Legal notice

Copyright and trademark information relating to this product release.

Copyright © 2000–2018 SDL Group.

SDL Group means SDL PLC. and its subsidiaries and affiliates. All intellectual property rights contained herein are the sole and exclusive rights of SDL Group. All references to SDL or SDL Group shall mean SDL PLC. and its subsidiaries and affiliates details of which can be obtained upon written request.

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including those in copyright in the content of this website and documentation are owned by or controlled for these purposes by SDL Group. Except as otherwise expressly permitted hereunder or in accordance with copyright legislation, the content of this site, and/or the documentation may not be copied, reproduced, republished, downloaded, posted, broadcast or transmitted in any way without the express written permission of SDL.

SDL Trados Studio is a registered trademark of SDL Group. All other trademarks are the property of their respective owners. The names of other companies and products mentioned herein may be the trademarks of their respective owners. Unless stated to the contrary, no association with any other company or product is intended or should be inferred.

This product may include open source or similar third-party software, details of which can be found by clicking the following link: “Acknowledgments” on page 35.

Although SDL Group takes all reasonable measures to provide accurate and comprehensive information about the product, this information is provided as-is and all warranties, conditions or other terms concerning the documentation whether express or implied by statute, common law or otherwise (including those relating to satisfactory quality and fitness for purposes) are excluded to the extent permitted by law.

To the maximum extent permitted by law, SDL Group shall not be liable in contract, tort (including negligence or breach of statutory duty) or otherwise for any loss, injury, claim liability or damage of any kind or arising out of, or in connection with, the use or performance of the Software Documentation even if such losses and/or damages were foreseen, foreseeable or known, for: (a) loss of, damage to or corruption of data, (b) economic loss, (c) loss of actual or anticipated profits, (d) loss of business revenue, (e) loss of anticipated savings, (f) loss of business, (g) loss of opportunity, (h) loss of goodwill, or (i) any indirect, special, incidental or consequential loss or damage howsoever caused.

All Third Party Software is licensed “as is.” Licensor makes no warranties, express, implied, statutory or otherwise with respect to the Third Party Software, and expressly disclaims all implied warranties of non-infringement, merchantability and fitness for a particular purpose. In no event will Licensor be liable for any damages, including loss of data, lost profits, cost of cover or other special, incidental, consequential, direct, actual, general or indirect damages arising from the use of the Third Party Software or accompanying materials, however caused and on any theory of liability. This limitation will apply even if Licensor has been advised of the possibility of such damage. The parties acknowledge that this is a reasonable allocation of risk.

Information in this documentation, including any URL and other Internet Web site references, is subject to change without notice. Without limiting the rights under copyright, no part of this may be reproduced, stored in or introduced into a retrieval system, or transmitted in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express written permission of SDL Group.
## Contents

1. Product Overview ......................................................... 1
2. SDL Trados Studio changes ............................................. 3
   - Changes introduced in Trados Studio 2019 SR1 .................... 4
     - Improved the alignment of content from previously translated files 4
     - SDL Language Cloud Terminology integration .................... 5
     - Optimized TM engine capabilities for higher accuracy and better leverage 6
     - Improved review flows in both Track Changes and TQA ......... 8
3. Resolved issues ............................................................ 9
   - Issues resolved in Trados Studio 2019 SR1 ...................... 10
4. Known issues ............................................................ 11
5. Installing Studio .......................................................... 15
   - Installation requirements ........................................... 16
   - Installing and upgrading ........................................... 18
6. Licensing Trados Studio .................................................. 19
   - Upgrading from SDL Trados Studio 2017 ......................... 20
   - Upgrading from SDL Trados Studio 2015 ......................... 20
   - Upgrading from SDL Trados Studio 2014 ......................... 20
   - Licensing Trados Studio 2019 SR1 from Trados Studio 2019 ... 21
   - Using Trados Studio 2019 SR1 with a network license ......... 21
   - Network licensing when upgrading from a previous version ... 21
7. Compatibility .............................................................. 23
   - Compatibility with previous Trados Studio versions .......... 24
   - Compatibility with other software ................................ 25
   - Upgrading to SDL Trados Studio 2019 SR1 and SDL MultiTerm 2019 CU 01 ..... 27
8. Supported releases ........................................................ 29
9. Localization ............................................................... 31
10. Further information ..................................................... 33
    - Help ............................................................... 34
    - Customer support ................................................ 34
1

Product Overview
SDL Trados Studio is a Computer Aided Translation (CAT) tool and translation memory software that helps you translate and manage translation projects faster and easier.

Trados Studio offers a complete environment for professional translators to edit and review projects, use agreed terminology and leverage machine translation results. As a project manager, you can use Trados Studio to effectively manage all aspects of translation projects.

See [https://docs sdl.com/SDLTradosStudio2019](https://docs sdl.com/SDLTradosStudio2019) for information on using Trados Studio.

**SDL AppStore**

You can extend and enhance the default functionality of your Trados Studio version through AppStore plug-ins. In the SDL AppStore you can:

- download apps which extend the Trados Studio functionality
- join the SDL AppStore Developer Program, if you are a developer interested in creating new Trados Studio apps.

**Freelancer and Starter versions**

The Freelance and Starter versions of Trados Studio cannot run on a domain-based network. This is the intended behavior for these two versions. If you want to run Trados Studio on a domain-based network, use the Express, Professional or the Studio Workgroup version instead.

See the [Studio comparison table](#) for more information on the differences between the Trados Studio editions.

**Product names**

For better readability, this document uses the short names for the following SDL products:

- SDL Trados Studio - Trados Studio
- SDL Trados GroupShare - Trados GroupShare
- SDL MultiTerm - MultiTerm
SDL Trados Studio changes
This section provides an overview of the new features, enhancements and other changes introduced in SDL Trados Studio including service releases.

Changes introduced in Trados Studio 2019 SR1

This section contains a list of new features and functionality that were introduced with the SDL Trados Studio 2019 SR1 release.

Improved the alignment of content from previously translated files

We made the process of aligning content from previously translated files more versatile and easier to handle by adding new alignment selection and connection capabilities, and introducing advanced split and search functionalities.

Operations with multiple selected segments

We removed the Alignment Edit Mode option from the Ribbon (in the Alignment view) and introduced a better way of scrolling and selecting segments. As a result, you can now perform operations on multiple selected segments directly in the Alignment Editor. You can more easily select and handle multiple segment pairs by using the new:

- Extended connection options
- Confirming or rejecting alignment connections
- Navigating to or finding specific alignments

This functionality helps you select and align up to 5 segments (as opposed to a maximum of 3 allowed until now), and enables you to better visualize the selection and the focus on the current segment (by removing the lag between these two operations).

More options for alignment connections

There are new segment connection possibilities. Besides the previous 1:1, 2:2, 1:3, 3:1 connections, you can now also create 1:4, 4:1, 1:5, 5:1 connections. Moreover, you can confirm or reject your alignments, and even disconnect all selections.

Go To segment pairs in alignment file

You can use the Go To functionality to quickly navigate to alignment segments based on their alignment status, quality or connection type.

Open an alignment file, go to the Home tab > Navigation > Go To and then define the criteria according to which you want to navigate the aligned segments:

- Status options: Confirmed, Unconfirmed, Any
• **Quality** options: *Good, Bad, Average, Any*

• **Connection** options: *Multiple Connection, Single Connection,Disconnected, Any*

This functionality can help you easily compare segment alignments (which fall under the same criteria), as well as quickly spot inconsistencies, missing alignments, or identify a particular segment you are interested in.

**Find segment pairs in alignment file**

You can search and find text in the **Alignment Editor** using the new **Find** functionality that supports simple text, regular expressions and wildcards.

This functionality helps you navigate results per source or target area using the **Find Next** button.

**Split and Insert segments in alignment file**

You can also split segments or insert new blank segments for a cleaner alignment result where needed.

Split is possible for both source segments and target segments, but is by design restricted for connections that exceed a 1:3 or 3:1 alignment. To split a segment, place your cursor in the source/target segment at the splitting point and, from the context menu, select **Split Segment**.

In addition to the automatic segment insertions added when splitting a segment, you can manually insert segments. To insert new segment rows, place your cursor inside a source or target segment, and, from the context menu, select **Insert After** or **Insert Before**, leading to a 1:0/0:1 connection depending on where the segment was inserted. This can benefit scenarios where the target document has translations that the source document did not have, or vice versa. As a result, great flexibility is achieved when editing diverging source-target content.

**Omit alignment metadata fields**

There is a new option to omit alignment metadata fields during TM import. The resulting TMs will not have these custom fields: **SourceFile, TargetFile** and **Quality**.

To omit metadata fields during TM import, go to the **Home** tab > **Import into Translation Memory** > **Advanced Import** > **Translation Memory Import Wizard** > **Alignment and TM Import Options** > clear the **Add alignment metadata** checkbox.

## SDL Language Cloud Terminology integration

**SDL Language Cloud Terminology** has reached version 1.0, ends its beta testing period and is now available as a free or paid subscription, depending on your translation needs. SDL Trados Studio is now fully integrated with **SDL Language Cloud Terminology**.

### SDL Language Cloud Terminology sign in and subscription details

When you set up an SDL Language Cloud account from within SDL Trados Studio for the first time, you need to:

1. Open SDL Trados Studio.
2. Select the **Sign In** area from the upper right-hand corner of any view.
3. Select **Not your account?** and go to the **SIGN UP** page.
4. Set your credentials (username and password), select the checkboxes related to privacy and consent, and then select **SIGN UP**.
Your SDL Language Cloud is created and you are logged in to SDL Language Cloud from SDL Trados Studio.

If you are running a Trial version of SDL Trados Studio, you need to opt for a subscription. If you are running a licensed version of SDL Trados Studio, you have automatic access to a Free subscription.

You can always purchase an SDL Language Cloud subscription which best suits your translation needs. Once logged in to SDL Language Cloud, select your account name, and then select the Visit the subscription page link. You are redirected to the SDL Language Cloud website where you can consult and/or purchase a subscription.

**SDL Language Cloud Terminology main functionalities**

With SDL Language Cloud Terminology you can:

- Create and manage termbases, add terms and share your terminology assets from the cloud. You can share termbases outside your account only if you are an LSP or a translation business provider, and you purchased a package.
- Customize the termbases by defining data categories and their structure.
- Customize the termbase definition instead of just using the predefined templates.
- Use terminology verification with the SDL Language Cloud termbases. Terminology verification for SDL Language Cloud works the same way as it does with SDL MultiTerm termbases.
- Benefit from higher quality results in searching, both when using linguistic as well as traditional character-based fuzzy searching.

**SDL Managed Translation packages in SDL Trados Studio**

SDL Managed Translation is also integrated with SDL Language Cloud Terminology. As a translator or reviewer, you can receive translation packages from SDL Managed Translation and then work with them in SDL Trados Studio.

If these packages contain SDL Language Cloud termbases that the project managers want you to use during translation/review, you can access these shared resources if you have an SDL Language Cloud account set up. Depending on your SDL Language Cloud subscription type (if you purchased one) and on the edit/read-only permissions the SDL Managed Translation project manager assigns you, you can either use or use&modify the SDL Language Cloud termbases.

**Optimized TM engine capabilities for higher accuracy and better leverage**

SDL Trados Studio 2019 SR1 introduces more accurate project scoping and budgeting, thanks to better leverage both in the area of context and fuzzy matching. Development efforts also targeted higher robustness and flexibility when working with TMs in different contexts and different settings. There are new processing mechanisms which ensure full compatibility across the supply chain and different SDL Trados Studio versions.
Redeveloped context matching for higher accuracy

We improved the way context matches are calculated to avoid incorrect context matches and unwanted duplicate matches in some cases.

Better fuzzy matching and an adjusted TM upgrade mechanism

We enhanced stemming for Western languages and made improvements in recognizing half/full-width characters for Japanese in particular. The current linguistic insight behind our TMs applies to segment matching and concordance matching, as well as upLIFT MatchRepair and upLIFT fragment matching.

You can reuse the TMs you created in previous SDL Trados Studio versions, but in order to benefit from the latest TM enhancement, we recommend that you upgrade all your older TMs using one of the available Translation Memory Upgrade mechanisms. All your older/legacy TMs are clearly marked by a triangle warning sign.

This functionality supports the interoperability between the TMs from different (and future) SDL Trados Studio versions.

TM reindexing is now prompted explicitly when changing basic settings

Changing any of the file-based TM settings (any recognition setting or variable) requires you to reindex your TM, namely to "refresh" it so it is updated with your preferences. Reindexing was required until now too, but now users are reminded that they need to reindex the TM they changed. All TMs which require reindexing are marked with a triangle warning sign (the same sign you would see for a legacy TM which needs to be upgraded).

To reindex your TM, simply upgrade your TM using one of the available Translation Memory Upgrade mechanisms.

Important TM compatibility considerations

SDL Trados Studio 2019 SR1 will prompt users to upgrade their TMs.

SDL Trados Studio 2017 SR1 will also receive a cumulative update release with the same enhancements.

Notice: SDL recommends that, once the TMs are upgraded, all users in the supply chain use the same SDL Trados Studio version upgraded to the latest CU. This means that all users should upgrade to one of the following SDL Trados Studio versions: SDL Trados Studio 2017 CU15 and SDL Trados Studio 2019 SR1. This will ensure that all users benefit from the context match and fuzzy match enhancements, as well as an overall reliability when changing recognizer settings. If an SDL Trados Studio 2017 or 2019 user remains on an older version and receives newer TMs, leverage issues will occur.

SDL Trados Studio 2015 users can download the TM Compatibility Plug-In for SDL Trados 2015 and back-convert the TMs created in SDL Trados Studio 2017 SR1 CU15 or SDL Trados Studio 2019 SR1, into the TM format used by SDL Trados Studio 2015; otherwise leverage will be adversely affected.
Improved review flows in both Track Changes and TQA

The improvements made in the Track Changes and Translation Quality Assessment (TQA) areas increase stability and effectiveness for all reviewers.

Track Changes improvements

Show Markup combo box

You can use the new Show Markup combo options to control whether you want to have review markup displayed while you are correcting or checking a translation:

- **Show Markup** shows all highlights (changes) you made as well as their corresponding formatting.
- **No Markup** hides all highlights, so all your tracked changes appear as normal text in the Editor.
- **Original** shows the original document without the changes that were added.

This functionality helps you switch between a more compact or a more detailed display of your changes, so you can control the depth at which you assess your reviewed file.

Add comments when Track Changes is active or when Assess Quality mode is active

You can add comments without having to select the text of a tracked change first.

This functionality saves you a lot of time by also making commenting more straightforward.

AutoCorrect enabled when Track Changes is active

You can control whether AutoCorrect is automatically enabled or disabled when Track Changes is active.

Go to File > Options > Editor > Review and select/clear the AutoCorrect checkbox.

TQA improvements

TQA on auto-propagated translations

For TQA items reported on auto-propagated translations, there is a new option to Assign severity of type 'Repetition' to auto-propagated TQA items.

Go to File > Options > Editor > Auto-propagation, under the Translation Quality Assessment section. This sets a severity of type 'Repetition' to the TQA items in auto-propagated translations and also sets the score to '0'.

Delete TQA item and its content

Deleting a TQA item of the Addition type, now also deletes the text that was added in the target segment.

Auto-complete the settings of the last added TQA item when you add a new TQA item

When adding a new TQA item, SDL Trados Studio now remembers the settings of the last TQA item you applied.

Improved display of TQA Severities

In the Severities options, when moving severities up or down, the focus is kept on the selected severity.
Resolved issues
SDL Trados Studio 2019 SR1 contains all previous cumulative updates for Trados Studio.

Issues resolved in Trados Studio 2019 SR1

The current list details the issues that were resolved in SDL Trados Studio 2019 SR1.

Main application issues

Context matches saved into a TM in a version lower than SDL Trados Studio 2017 SR1 do not become 100% matches anymore

The changes required for introducing upLIFT for Japanese and Chinese TMs in SDL Trados Studio 2017 SR1 affected the way SDL Trados Studio handles these TMs. Context matches from TMs used in a previous SDL Trados Studio version used to become 100% matches in SDL Trados Studio 2017 SR1 and later.

This is not happening anymore, as SDL Trados Studio 2019 SR1 preserves context matches added in a TM before updating to SDL Trados Studio 2017 SR1.

Note: There is a remaining issue with old TMs that were not upgraded. Please see “Known Issues” on page 11.

Integration issues

Changes made to project settings by users who have the "Edit Project" permission no longer resets the target language for different users

Users who have the "Edit Project" permission in SDL Trados GroupShare (Project Managers, typically) could make changes to a project’s settings, thus resetting the target language for all translators working on a particular target language translation. This is now fixed, and translators working on a particular target language can continue working on their designated source language-target language combination, even when changes are made to the project settings during the project lifecycle.

Performance is restored when working with a large number of active server-based TMs from SDL Trados GroupShare 2017

When opening a document or accessing the Translation Memory and Automated Translation settings page, the TMs would display poor performance in the case of a very large number of active TMs from SDL Trados GroupShare 2017. This is now fixed, and the number of active server-based TMs is no longer a blocker when accessing project settings.

TM matches from Machine Translation (MT) providers are correctly retrieved

When the list of active TMs contained a TM from an MT provider, but the TM would not be first in the TM list, SDL Trados Studio would not retrieve matches from it. Users would have to revert the order of active TMs in the list and place the MT one at the top of the list, for matches to be generated during translation. This is now fixed, and the order in which TMs are listed no longer affects match retrieval irrespective of the placement and nature of the TMs provided.
4

Known issues
This section lists the limitations associated with the 2019 release of SDL Trados Studio.

Main application issues

These are the issues that SDL considers important to resolve and that have top priority for the development team to fix in a future SDL Trados Studio release.

**Replace with regular expressions in the Editor is not working in Trados Studio 2019 SR1**

The *Find and replace* functionality in the Editor is not working for RegEx replacements. The development team is working on a fix to be delivered in the next cumulative release for Trados Studio 2019 SR1.

**Not upgrading a TM could lead to lost context matches**

When you open a pre-Trados Studio 2019 SR1 translation memory in TM view, you are prompted to upgrade the TM. If you do not upgrade the TM and export the TM to TMX, then use that TMX file in the Upgrade Translation Memories wizard, you might find that context matches become 100% matches in the resulting TM.

TMs which are imported from earlier SDL Trados Studio versions into the latest SDL Trados Studio version can still be used during translation. However, the quality of the retrieved TM matches is lower. Therefore, SDL recommends that you upgrade your older TMs when you use them with the latest SDL Trados Studio version.

**Limited compatibility between .sdlalign files created in SDL Trados Studio 2019 SR1, but used in earlier SDL Trados Studio versions**

The Alignment Editor provides SDL Trados Studio 2019 SR1 users with several new features regarding: segment connection, segment splitting and segment insertion. When an SDL Trados Studio 2019 SR1 user sends an *.sdlalign file to a user who has an earlier SDL Trados Studio version, the latter user will not be able to benefit from the changes performed on the file via the new 2019 SR1 features. For example, inconsistencies will occur in terms of segment connections and numbering.

SDL recommends one of the following:

- Ensure that the users you send your *.sdlalign file to have upgraded to SDL Trados Studio 2019 SR1.
- Send the users (who did not upgrade) a TM containing the results of your *.sdlalign file.

**Limited searching in localized online help from Tell Me**

Because the SDL Trados Studio help is not translated in Italian, Korean or Russian, Tell Me will return data from the English version of the help when the user interface language is set to Italian, Korean or Russian.

**Tell Me search does not return useful results with Japanese or Chinese language input**

Using the Tell Me search mechanism when in SDL Trados Studio 2019 with the user interface set to one of the two character-based languages has the following limitations:

- Searching for partial words is not possible; only terms that begin with the input text or terms that follow a set of alpha characters are matched.
- To search for UI terms that contain spaces used, you must fill in those spaces precisely so that the desired term is returned. This only applies for searching commands and features with Tell Me. Searching for terms in the online help works with no issues. See more information at: [https://gateway.sdl.com/apex/communityknowledge/articleName=Tell-Me-search-for-JA-ZH](https://gateway.sdl.com/apex/communityknowledge/articleName=Tell-Me-search-for-JA-ZH).
Limited Trados Studio editions on domain-based networks

When you try to run the Freelance or Starter version of SDL Trados Studio on a domain-based network, SDL Trados Studio informs you that you cannot run these versions on such a network. This is by design and does not occur on workgroup-based networks or stand-alone computers.

Importing QA checker profiles from language pair level

You can upload a QA Checker profile file created in the general QA Checker settings to the QA Checker settings from the language pair level and the five settings categories from the QA Checker at language pair level will be changed.

If you upload a QA Checker profile file created at language pair level to the general QA Checker settings, only the settings available at language pair level will be changed.

Note: If you upload a QA Checker profile file created at language pair level to the general QA Checker settings of a version older than SDL Trados Studio 2019, the settings available at language pair level will be changed and all other settings will revert to default.

Integration issues

SDL Trados Studio - SDL MultiTerm compatibility at installation

SDL Trados Studio 2019 SR1 is compatible only with SDL MultiTerm 2019 CU01.

SDL Trados Studio 2019 CU01 is compatible only with SDL MultiTerm 2019.

Cross-installations are not available at this point. In case you have incompatible installations of SDL Trados Studio - SDL MultiTerm on your machine, uninstall both SDL Trados Studio and SDL MultiTerm, and re-install the compatible versions (as explained above).

Limited interchange between the SDL Language Cloud providers (2015 vs. 2019) used in projects

When you open projects and project templates which contain an SDL Language Cloud MT provider with an SDL Trados Studio version that is earlier or later than the version used to create the project and project template, the Language Cloud provider is disabled. Due to supporting Adaptive MT, projects that use the new Language Cloud provider (available since 2017) are not compatible with earlier versions of the Language Cloud provider (prior to 2017). The Language Cloud providers are very different and projects cannot be freely interchanged.

To bypass this limitation, you must remove the Language Cloud provider from the Translation Memory and Automated Translation list and then add it again.

Limitations to switching between different servers when adding server-based termbases

When you want to add a server-based termbase as a resource to SDL Trados Studio but you need to connect to a different server than the one you currently have access to, the connection details for the new server will not be updated. As a result, you will not be able to use the new server and its hosted termbases.

The current workaround for this issue is for you to delete the server (and its connection details) you no longer want to use, and add the new server (and its connection details) from: New Project wizard > Termbase step > Servers button > Servers dialog.
Known issues
5

Installing Studio
This section contains general information on installing SDL Trados Studio 2019 SR1 and the technical requirements for the installation.

For step-by-step instructions on how to install and maintain Trados Studio, see the Trados Studio Installation guide.

### Installation requirements

#### Hardware requirements

- A Microsoft Windows-based PC or an Intel-based Apple Mac computer running Windows as an operating system
- Up to 2.5 GB of available disk space to run the Trados Studio installer
- 2 GB of available disk space to run Trados Studio
- A 32-bit (x86) or 64-bit (x64) processor
  - **32-bit (x86) OS**
    - 1 gigahertz (GHz) or faster processor
    - 4 GB RAM
    - A screen resolution of 1280x1024 pixels and 256 colors or higher
  - **64-bit (x64) OS**
    - A recent processor with dual or multi-core technology
    - 8 GB RAM
    - A screen resolution of 1280x1024 pixels and 256 colors or higher

For optimum performance, SDL recommends using 64-bit operating systems, a recent processor with dual or multi-core technology, 16 GB of RAM and SSD storage.

#### Operating Systems

**Supported OS**

- Trados Studio 2019 SR1 runs on the latest build of Windows 10, the latest updated version of Windows 8.1 and the latest service-packed version of Windows 7.
- Trados Studio also supports Windows Server 2016, Windows Server 2012 R2 and Windows Server 2008 R2 to facilitate certain scenarios, for example, where Citrix or Remote Desktop Services are used.

**Unsupported OS**

- Trados Studio does not support earlier operating systems such as Windows 8, Windows Vista, Windows XP and Windows 2003 Server.

**Recommended OS**

SDL recommends that you use Windows 10 as being the current and best supported OS from Microsoft.
Software


The new file types for Microsoft Office files types do not require Microsoft Office to be installed. However, if you use the legacy file types:

- For processing RTF and PDF files, Trados Studio requires Microsoft Word 2003 or higher. If you are using the real-time preview feature, SDL recommends that you use Microsoft 2013, 2010 or 2007 as Word 2003 may cause certain issues. You can find potential workarounds in the SDL Gateway.
- For Microsoft Excel 2000-2003, Trados Studio uses a processor to convert to Excel 2007 and back. For this to work correctly, install the Microsoft 2007 compatibility pack from the Microsoft Download Centre.

Browsers

- The Welcome tab with drag-and-drop capabilities is only available on PCs with Microsoft Internet Explorer 10 or later.
- On PCs with Microsoft Internet Explorer 9 or earlier, the old Welcome tab content is displayed.
- The SDL Language Cloud dashboard and SDL Language Cloud Terminology require the latest version of Microsoft Edge, Google Chrome, Mozilla Firefox, and Internet Explorer 11 or later to work.

Trados Studio Help

The Trados Studio Help buttons are context sensitive and redirect to the online deliverable on the SDL Documentation Center. This means that to get access to the latest updated help for Trados Studio you need an Internet connection and one of the following Internet browsers installed:

- Microsoft Edge
- Microsoft Internet Explorer 10 and later
- Google Chrome (latest version)
- Mozilla Firefox (latest version)
- Safari 7 and later

If you need to consult the full product documentation in a location with no Internet access, you can download the WebHelp documentation deliverable, a ZIP file containing all the documentation as static Web pages.

To download the ZIP file, access the following link: SDL Trados Studio 2019 full documentation as WebHelp deliverable. Unpack this ZIP file in a location of your choosing and open index.html in an Internet browser.

Please note that the documentation may be subject to change after the product has been released. The live documentation resource at https://docs.sdl.com/SDLTradosStudio2019 is always the most up-to-date resource.
Installing and upgrading

**Trados Studio 2019 installation**

You can download the Trados Studio installer from your [SDL Account](#).

When installing Trados Studio, make sure that you have administrator rights and that no other software is running.

Trados Studio 2019 SR1 installs side-by-side with previous major versions of Trados Studio.

However, as a service release for Trados Studio 2019, Trados Studio 2019 SR1 installs on top of previous Trados Studio 2019 versions and cannot run alongside them.

You can find a full list of the software, including third-party software installed with Trados Studio in the [SDL Trados Studio 2019 Installation Guide](#).

**Trados Studio 2019 upgrade**

When you upgrade from Trados Studio 2017, you can use the [Studio Migration Utility](#) to move all your configurations to Trados Studio 2019.

If you plan to install and use Trados Studio 2017 and Trados Studio 2019 side-by-side, install Trados Studio 2017 first.

If you are using a license server, after upgrading, you need to connect to a license server with SDL License Server Manager 2019 installed.

Visit [https://gateway.sdl.com](https://gateway.sdl.com) for the latest information on installation and upgrade issues.
Licensing Trados Studio
This section contains information on special requirements for licensing certain SDL Trados Studio versions.

For detailed instructions on how to activate single and network Trados Studio licenses, see the SDL Licensing Help.

For any licensing or installation issues, contact support here: https://gateway.sdl.com/liveagentlicensing

### Upgrading from SDL Trados Studio 2017

After upgrading from SDL Trados Studio 2017 to Trados Studio 2019 SR1, your original license will be automatically removed from your account.

If you want to use Trados Studio 2019 SR1 side-by-side with SDL Trados Studio 2017, you can use both on the same machine using the Trados Studio 2019 SR1 license. This is only possible for single-user licenses.

### Upgrading from SDL Trados Studio 2015

After upgrading from SDL Trados Studio 2015 to Trados Studio 2019 SR1, your original license will be automatically removed from your account. To continue using an older version, you should consider purchasing a full license instead of an upgrade.

If you want to try Trados Studio 2019 SR1 side-by-side with SDL Trados Studio 2015, you can use the 30-day trial that is available in Trados Studio 2019 SR1.

### Upgrading from SDL Trados Studio 2014

Trados Studio 2019 SR1 uses a different type of activation code than SDL Trados Studio 2014. After upgrading from SDL Trados Studio 2014 to Trados Studio 2019 SR1, your original license will be automatically removed from your account. To continue using an older version, you should consider purchasing a full license instead of an upgrade.

If you have a Trados Studio Freelance edition, you can continue to use SDL Trados Studio 2014 alongside Trados Studio 2019 SR1 on the same machine until you deactivate the older product's license.

If you want to try Trados Studio 2019 SR1 side-by-side with SDL Trados Studio 2014, you can use the 30-day trial that is available in Trados Studio 2019 SR1.
Licensing Trados Studio 2019 SR1 from Trados Studio 2019

If you have a SDL Trados Studio 2019 license, you can upgrade to Trados Studio 2019 SR1 for free. As a service release for Trados Studio 2019, Trados Studio 2019 SR1 shares the same activation code.

Using Trados Studio 2019 SR1 with a network license

SDL Trados Studio 2019 SR1 uses licensing technology based on SafeNet network licensing. To activate Trados Studio 2019 SR1 network licenses you need the latest version of SDL License Server Manager.

Multiple product editions on a license server

In Trados Studio 2019 SR1, you can connect to a network license server that has multiple product licenses active and choose what Trados Studio edition to use. For more information on how to connect to a license server, see the SDL Licensing Help.

Remote Desktop connections

When using a Remote Desktop Connection, you can run more than one instance of Trados Studio on the remote workstation; however, each instance will consume a network seat.

When using Remote Desktop Services or Citrix XenDesktop, you can only activate Trados Studio with a network license. Each user session consumes one network seat until all available seats are exhausted.

Network licensing when upgrading from a previous version

Upgrading from Trados Studio 2011 and 2014 pre-SP2

If you are a Trados Studio 2011 or 2014 pre-SP2 user upgrading to Trados Studio 2019 SR1 in a network-licensing scenario, install the new SDL License Server Manager to activate the Trados Studio license. You can continue to use Trados Studio 2011 or 2014 pre-SP2 with network licensing using the legacy License Server Toolkit.
Upgrading from Trados Studio 2014 SP2, 2015 or 2017

If you are a Trados Studio 2014 SP2, 2015 or 2017 user upgrading to Trados Studio 2019 SR1 in a network-licensing scenario, upgrade to the latest version of SDL License Server Manager to activate the Trados Studio license.
Compatibility
Compatibility with previous Trados Studio versions

SDL Trados Studio 2019 SR1 can run alongside previous versions of Trados Studio.

However, as a service release for Trados Studio 2019, Trados Studio 2019 SR1 installs on top of previous Trados Studio 2019 versions and cannot run alongside it.

Compatibility of the latest release with SDL Trados Studio 2015 or SDL Trados Studio 2017

Trados Studio 2019 and SDL Trados Studio 2015 or SDL Trados Studio 2017 have the same project and package format.

Compatibility of the latest release with SDL Trados 2007

You can also install Trados Studio 2019 SR1 alongside SDL Trados 2007.

Trados Studio 2019 SR1 also contains its own version of the SDL Trados 2007 infrastructure so all use cases that require SDL Trados 2007 still work even if you do not have SDL Trados 2007 installed.

Backward compatibility

Trados Studio 2019 SR1 supports the following:

- S-Tagger
- ITD
- TTX
- Upgrading TMW
- Upgrading MDB

Backward compatibility

Trados Studio 2019 SR1 supports the following:

- S-Tagger
- ITD
- TTX
- Upgrading TMW
- Upgrading MDB

For extensive information on backward compatibility and upgrading TMs, see the SDL Trados Studio 2019 Help and the SDL Trados Studio 2019 Migration Guide.

Plug-in for making the latest TMs compatible with the SDL Trados Studio 2015 infrastructure

When working with translators who do not have the latest SDL Trados Studio version, you can still send them your TMs and avoid any backward compatibility issues. This applies to all SDL Trados Studio 2015 users.

SDL Trados Studio 2015 translators can use TMs generated in more recent SDL Trados Studio versions (2017 SR1 CU15 and 2019 SR1), if they convert them as per the following instructions:

1. Go to SDL AppStore and download the TM Compatibility Plug In for free.
2. Run the SDL Plugin installer.
3. Open **SDL Trados Studio 2015**.
4. Go to the **Home** tab, select **Back Convert TM**, browse for the TM and select **Yes** (in the confirmation message).

SDL Trados Studio 2015 users can also be prompted to back convert their TM at the end of the **Project Creation** wizard or when they add the TM as a new resource to an existing project.

### Compatibility of older TMs with the latest SDL Trados Studio release

When using a TM from an earlier SDL Trados Studio release with the latest SDL Trados Studio release, you will have no problem accessing its resources during translation. However, you will not be able to benefit from the latest TM performance enhancements related to upLIFT fragment matches, upLIFT MatchRepair, fuzzy matches and context matches.

**Tip:** SDL recommends that you upgrade all your older or earlier TMs to the latest SDL Trados Studio release version by using one of the available Translation Memory Upgrade mechanisms. All TMs which require an upgrade (either because they are older or they require reindexing because their settings have changed) are flagged with an exclamation mark.

### Compatibility with other software

**SDL Passolo**
SDL Trados Studio 2019 SR1 is compatible with the latest CUs available for SDL Passolo 2018 and Passolo 2016.

**MultiTerm Desktop**
You can use SDL MultiTerm 2019 and SDL MultiTerm 2017 on the same computer as Trados Studio 2019 SR1.

SDL Trados Studio 2019 SR1 is compatible only with SDL MultiTerm 2019 CU01.

SDL Trados Studio 2019 CU01 is compatible only with SDL MultiTerm 2019.

Cross-installations are not available at this point. In case you have incompatible installations of SDL Trados Studio - SDL MultiTerm on your machine, uninstall both SDL Trados Studio and SDL MultiTerm, and re-install the compatible versions (as explained above).

### Cross-compatibility between SDL Trados Studio and SDL MultiTerm

<table>
<thead>
<tr>
<th>SDL MultiTerm 2017 CU6</th>
<th>SDL Trados Studio 2017 SR1 CU14</th>
<th>SDL Trados Studio 2017 SR1 CU15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>SDL MultiTerm 2017 CU7</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>SDL MultiTerm 2019</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Compatibility

<table>
<thead>
<tr>
<th>SDL MultiTerm 2019</th>
<th>SDL MultiTerm 2019 CU 01</th>
<th>SDL Trados Studio SR1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Trados GroupShare**

Trados Studio 2019 SR1 is compatible with Trados GroupShare 2017 and Trados GroupShare 2015.

Trados Studio 2019 SR1 cannot work with Studio GroupShare 2014 and below.

**SDL enterprise software**

Trados Studio 2019 SR1 is compatible with all bilingual files and packages created in any version of:

- SDL WorldServer 11.3.3 and 10.4.5
- SDL TMS 12.2 and 12.1

**SDL TMS and Trados Studio extraction settings**

SDL guarantees that within two months of a Trados Studio release (major version or service release), SDL TMS will update its Filters to synchronize with Trados Studio. Currently, SDL TMS does not include an auto-update feature to immediately match the changes that Trados Studio makes to its File Types via Cumulative Updates. This means that sometimes you may find differences between file content extracted as translatable text in Trados Studio and in SDL TMS. To ensure full compatibility between Trados Studio and SDL TMS, SDL recommends that you use the version of Trados Studio that contains the same set of File Types as your SDL TMS. You can also manually configure the SDL TMS Content Types settings to synchronize the content extraction logic.

For more information on which version of Trados Studio is in line with SDL TMS, contact SDL Support or check the SDL TMS release notes.

**Adobe InDesign and InCopy**

Trados Studio supports the CC and earlier versions of Adobe InDesign and InCopy. CC is the current version of Adobe InDesign and InCopy at the time of the 2019 release of Trados Studio.

If Adobe releases new versions of InDesign and InCopy following the Trados Studio 2019 SR1 release, SDL may implement support for these through another service release or through a cumulative update. Until then, you can use the **Process unsupported file versions** option in Trados Studio to open any IDML and ICML files. This option enables compatibility for files created in higher Adobe versions than the one available at the time of the last Trados Studio update.

This option is available on the **Common** page of these two **File Types** settings.

**Adobe FrameMaker**

Upgrading to SDL Trados Studio 2019 SR1 and SDL MultiTerm 2019 CU 01

To avoid any usage incompatibility between SDL Trados Studio and SDL MultiTerm, you must upgrade both these products to their latest version.

About this task
When opening either SDL Trados Studio 2019 or SDL MultiTerm 2019, a notification appears with the option to download SR1 for SDL Trados Studio 2019 and CU1 for SDL MultiTerm 2019.

However, if you do not receive this notification, please follow the steps below to download SDL Trados Studio 2019 SR1 and SDL MultiTerm 2019 CU1.

Procedure
1. Exit SDL Trados Studio 2019 and SDL MultiTerm 2019, and close any Microsoft Office applications.
2. Login to your “SDL Account” on page 11.
3. Go to the Downloads section.
   - Your SDL Trados Studio 2019 SR1 and SDL MultiTerm 2019 CU1 download is clearly marked.
4. Expand the new SDL Trados Studio 2019 SR1 / SDL MultiTerm 2019 CU1 product name and you will find the required downloads.
5. Select Download for each application and save the executable files to your local hard disk.
6. Run both .exe files one at a time and follow the wizard-driven process.

Results
The SDL Trados Studio 2019 SR1 installer will detect the currently installed SDL Trados Studio 2019 software and uninstall it in the background before installing SDL Trados Studio 2019 SR1. If you have any problems with the installation or licensing of SDL Trados Studio 2019 SR1, please submit a request in the Solution Finder. The same applies for any issues you may encounter with SDL MultiTerm 2019 CU 01.
Compatibility
Supported releases
SDL Trados Studio 2019 is the fully supported release of Trados Studio. SDL continues to support Trados Studio 2017 as the limited support release.

Following the release of Trados Studio 2019, SDL has moved Trados Studio 2015 to an extended support period that lasts until the 31 December 2018, before moving to the retired state.

Trados Studio 2014, 2011 and 2009 are in retired state and are no longer supported.

SDL does not provide technical assistance, issue service packs or hotfixes for retired releases. For Trados Studio 2019 and Trados Studio 2017 SDL will issue service releases and cumulative updates as and when required.

## Limited support

The following file types benefit from limited support (no new feature development):

- Word binary *.doc
- PowerPoint *.ppt
Localization
The user interface and the Help for SDL Trados Studio 2019 are available in the following languages:

- German
- French
- Spanish
- Japanese
- Simplified Chinese
- Italian (user interface only)
- Russian (user interface only)
- Korean (user interface only)
Further information
This section lists the resources available for getting more help and information on **SDL Trados Studio**.

**Help**

**SDL Trados Studio Help**

The Help for Trados Studio 2019 is available by selecting **Help tab > Help Topics** in Trados Studio. You can also go to [https://docs.sdl.com/SDLTradosStudio2019](https://docs.sdl.com/SDLTradosStudio2019) to access the Trados Studio Help. Here you can find links to:

- Information on installing and upgrading to Trados Studio 2019
- Videos and information on how to get started with SDL Trados Studio
- Help topics about working with SDL Trados Studio and Trados GroupShare projects.

**Trados GroupShare Help**

If you are working with Trados GroupShare projects, you may also find the [SDL Trados GroupShare Help](https://docs.sdl.com/SDLTradosGroupShare) useful. Here you can find links to:

- Information on installing and upgrading Trados GroupShare
- Help topics describing how to work with Trados GroupShare

**MultiTerm Help**

See the [SDL MultiTerm Help](https://docs.sdl.com/SDLMultiTerm) for more information on working with termbases.

**Customer support**

To contact Technical Support, connect to the Customer Support Web Portal at [https://gateway.sdl.com](https://gateway.sdl.com) and log a case for your SDL product. You need an account to log a case. If you do not have an account, contact your company's SDL Support Account Administrator.

**Creating a Support and Maintenance contract**

You need valid Support and Maintenance contract to log a support case. If you do not have a valid Support and Maintenance contract to see your Support options go to your SDL Account:

**Procedure**

1. Go to [www.sdl.com](http://www.sdl.com).
2. Select **Account login** and log in with your email and password.
3. Select your profile name and then **Support**
4. Complete registration by filling in your details.

If you have any other issues regarding Trados Studio, go to [SDL Trados Translation Productivity Community](https://community.sdl.com).
Acknowledgments
SDL Trados Studio includes open source or similar third-party software.

**#ziplib**

#ziplib (SharpZipLib, formerly NZipLib) is a Zip, GZip, Tar and BZip2 library written entirely in C# for the .NET platform. It is implemented as an assembly (installable in the GAC), and thus can easily be incorporated into other projects (in any .NET language).

**Apache log4net**

The Apache log4net library is a tool to help the programmer output log statements to a variety of output targets. log4net is a port of the Apache log4j™ framework to the Microsoft® .NET runtime.

**Hunspell**

Hunspell is the spell checker of LibreOffice, OpenOffice.org, Mozilla Firefox 3 & Thunderbird, Google Chrome, and it is also used by proprietary software packages, like Mac OS X, InDesign, MemoQ, Opera and SDL Trados Studio.

**ICU (International Components for Unicode)**

ICU is a mature, widely used set of C/C++ and Java libraries providing Unicode and Globalization support for software applications. ICU is widely portable and gives applications the same results on all platforms and between C/C++ and Java software.

**SafeNet Sentinel**

SafeNet’s Sentinel software licensing products and software protection solutions provides software publishers control and visibility into how their applications are deployed and used.

**Spring.NET**

Spring.NET is an application framework that provides comprehensive infrastructural support for developing enterprise .NET applications. It allows you to remove incidental complexity when using the base class libraries makes best practices, such as test driven development, easy practices.

**WiX**

The WiX toolset builds Windows installation packages from XML source code. The tool-set integrates seamlessly into build processes.

**Xerces-C++**

Xerces-C++ is a validating XML parser written in a portable subset of C++.